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6. If you need to set recurrences, tap the arrow in the Recurrence selection box, and 

select an item from the list. If the item you want is not listed, tap Edit pattern, and 

the Edit pattern dialog box appears. 

  
7. Then, when you return to the Tasks dialog box, it will look a little different than when 

you first saw it, as show below.  

  

8. Finally, if you wish this task to be private, tap the box next to Private to make a 

check, and if you wish to attach a reminder to this task, check the box next to 

Reminder. 

9. Tap OK to save settings. 

 If you wish to exit without saving input data, tap Cancel.  
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2) Editing a task 

1. Double-tap the task you wish to edit, or tap Edit Item on the Edit menu. 

2. Modify the contents of the task.  

3. Check to see if the modified contents are correct, then tap OK.  

If you wish to exit without saving the modified contents, tap Cancel.  

 

3) Deleting a task 

After selecting the task you wish to delete, tap Delete Item on the Edit menu or tap the 

Delete button ( ), and the selected item is deleted. 
  

4) Deleting a completed task 

To delete completed tasks, tap Delete Completed Task on the Edit menu and all 

completed tasks are erased. 

 

5) Finding tasks 

You can use this feature to find a specific task. 

1. Tap Find on the Tool menu, or tap the Find icon ( ).  
The Find dialog box appears.  

  

 

2. Input the data needed in searching in the given box next to Find, and select an item 

from Type if needed. 

3. Tap Search. 
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IV. Memo 
 

(1) Features 

The memo program saves contents that you have handwritten using the stylus. The 

number of memos that can be stored will vary depending on the memory.  

 

1) Functions of each menu 

1. File 

 

 

2. Edit 

 

 

3. Navigate 

 
 

4. Tools 

 

 

 

Used to create new Memo 
Used to open a Memo file  
Used to save Memo 
Used to save as another name 
Used to save current page as JPG

Used to save all pages as JPG 

Used to insert page 
Used to delete page 

Used to clear page 

Used to go to next page 

Used to set pen weight 
Used to set pen color 

Used to go to previous page 

Used to set eraser weight 

Used to convert to pen mode 
Used to convert to eraser mode 

Used to find recent documents 

Used to exit 
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2) Memo Screen 

 
 

 

(2) How to use Memo 

1) Creating a New Memo 

1. Tap New on the File menu, or tap the New Memo button ( ), and the New Memo 
window appears.  

2. Draw in what you want using the stylus.  

3. Tap Save on the File menu or tap the Save button ( ) to save the Memo.  
 

 

2) Opening an existing Memo 

1. Tap Open on the File menu or tap the Open button ( ). The Open dialog box 
appears. 

  

2. Tap the folder which holds the file you wish to open and double-tap the file.  

 

3) Saving a Memo 

1. Input the contents you want in Memo. 

2. Select Save or Save as on the File menu or tap Save to save it. 
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4) Saving a Memo as JPG file 

 

As a Memo, saved as CMO file, is readable on only the Memo program, 

and not readable on other programs, it can is readable on other 

programs by saving it as JPG file. 

 

1. Input the contents you want in Memo. 

2. Select Export Current Page to JPG or Export All Pages to JPG on the File menu. 

 

5) Selecting Pen or Eraser and setting Preferences 

Select Pen or Eraser on the Tools menu or select the Pen or Eraser icons. 

In order to set up Preferences for Pen or Eraser, select Pen weight, Pen Color or 

Eraser Weight on the Tools menu. 
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V. Calculator 
(1) Features 

Your PC-EPhone’s calculator consists largely of a calculator type selection, an top 

selection, equation input, outcome, numeral keys, function keys, and operators. The 

convertible has an additional panes for unit selection. 

 

Calculator Type 
selection 

Enables you to select the type of calculator (Standard, 
Scientific, Convertible). 

Keep on Top 
selection 

Enables you to keep the calculator screen on top of all 
other programs. 

Equation input Displays the equation to be calculated. 

Outcome Displays the outcome of the operations. 

Numeral keys Enables you to input the numbers used in the equation. 

Function keys Enables you to edit the equation. 

Operators Enables you to insert operators in the equation. 

Unit selection When converting units, enables you to select the base 
unit. 

 

 

(2) How to use Calculator 

1) Changing Calculator types 

 Tap the arrow of the selection screen on the upper left hand corner, and a drop-down list 

of calculator types is displayed. Select the desired calculator (Standard, Scientific, 

Convertible).  

  

 

 

2) Keeping the calculator on top 

 In order to keep the calculator displayed on top of all other programs, tap Top on the 

second selection window. To cancel this function, tap Hide. 
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3) Standard Calculator 

 Select Standard on the calculator menu. 

  
 

4) Scientific Calculator 

Select Scientific on the calculator menu. 

Use the keys on the scientific calculator as you would on the standard calculator. 
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5) Convertible Calculator 

 Select Convertible on the calculator menu. 

  

 
1. First, select the weight or measure you want to convert (Length, Weight, Volume, 

Size, Temperature). 

  
 When you select a Weight or Measure, the two lists below display units 

corresponding to the selected weight or measure.  

2. Select the unit to convert and the unit to convert into. 

 When you select a unit, it is displayed in the windows above the lists and next to the 

From and To panes.  

3. Input the quantity to be converted.  

4. Tap Enter.  

 

 

 The calculator program can perform equations within 15 digits. 
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VI. Recorder 
Recorder is used to record simple sounds or to play back existing Wave files.  

 

(1) Features 

 

1) Record/Play Status display 

  
 

Play Button  
 Used to Playback recorded contents or common wave files.  

Record Button  
 Used in recording.  

Stop Button  
 Used to stop playback or recording.  

Open File Button  
 Used to open a file for playback.  

Save File Button  
 Used to save the recorded file as a different name.  

Recording Settings Button  
 Used to change recording settings.  

Exit Button  
 Used to close the recorder program.  

 

 

 



Applications Page 7-31 

2) Recording Settings Screen 

 

In Settings, you can set the Sampling rate and bit, which determine the quality of the recording.  

Quality Selection Pane  

 Displays the available Sampling rates and bits, and is used when selecting the 

desired quality.  

Record Sensitivity 

 Used to adjust sensitivity while recording.  

 

(2) How to use the Recorder 

1) Running the Program 

 To run the Recorder Program, press the Record button on the right side of your PC-

EPhone or tap the Record icon.  

 

2) Recording 

 Tap the Record icon on the bottom of the Record screen or press the Record button on 

the right side of your PC-EPhone once more with the recorder program running. 

  

 To stop recording, tap the Stop button on the bottom of the Recorder or press the record 

button on the right side of your PC-EPhone. On suspension, the recorded contents are 

saved as a temporary file. This temporary file is saved Record.wav form in My 

Computer\Temp Folder.  
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3) Saving recorded file as another name 

1. Tap SAVE right after you have completed recording. The Save as dialog box 

appears.   

  
2. Select the location you want to save at in the browser window and input the file 

name in the file name input box.  

3. Tap OK. However, if you do not want to save, tap X (Exit).  

 

4) Opening files for playback 

 To recall prerecorded files or common WAV files,  

1. Tap the OPEN button. 

The Open dialog box appears.  

2. Select the file you wish to play back from the browser window, then tap OK. 

If you do not want playback, tap X (Exit).  

 

5) Playing Back 

 To play back the contents you have just recorded or a selected file, follow these steps.  

 Just after recording, tap the Play button to play back right away.  

 To play a file you have recorded before or a common wave file,  

 

Select the file to be played back following the steps in “4) Opening files for playback” 

and tap Play. When the playback time of the file ends, playback is suspended 

automatically.  

To stop in the middle of playback, tap Stop.  

To pause in the middle of playback, tap Pause.  

 

6) Pausing 

 To pause in the middle of playback or recording, tap Pause. 

 

7) Selecting recording quality 

 Recording quality is directly associated with available recording time. High values of 

Sampling rates(KHz units) and bits require that much more memories, therefore 
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shortening the time available for recording. Therefore, change the settings after checking 

the current memory status. 

 

1. Tap OPTION. The Setting dialog box appears.  

2. Select the desired recording quality. 

3. Tap OK. 

4. Check to see if the selected recording quality is displayed on the recording quality 

window.  
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VII. Microsoft Pocket Word 
As you would use Microsoft Word on your desktop PC, you can create and edit 

documents(.pwd) and templates(.pwt) in Pocket Word. First, place the cursor in the document 

window, and start by selecting Outline or Normal on the View menu. Pocket Word also 

provides a Spelling Checker feature and enables you to edit texts using the menu or commands. 

You can also access international characters or symbols for currencies on the Tool menu. 

Text(.txt) files remove all the formats, whereas rft(.rtf) files keep the formats. 

 

1) Creating a new Document 

1. Tap New on the File menu, then tap Document from Template. 

2. Select a template such as Meeting Notes, then tap OK. 

3. Tap Save on the File menu. 

4. Input the file name, then tap OK. 

5. Change the template contents. 

 

 

To view the document in a larger size, tap Full Screen on the View 
menu. 
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Chapter 8 

Accessories 
 

 

 

CYBERBANK provides you with various accessories to help you use your PC-EPhone more 

conveniently. Aside from the accessories that come with the purchase of your PC-EPhone, you can 

also purchase extraordinary accessories to endow your PC-EPhone with even more functions.  

 

In addition, you can better use your PC-EPhone’s features by expanding memory storage space and 

connecting to various external devices (including Camera, LAN) using CompactFlash Memory Cards. 

 

This chapter provides you with information on:  

 

 

CYBERBANK Accessories 

CF (CompactFlash) Memory Card  
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I. CYBERBANK Accessories 

The accessories illustrated below are provided upon PC-EPhone purchase. Options must be 

purchased separately from the product.  

 

 

 

 

 

 

 

(1) Stylus 

Used to input various data and to press the 

Reset button. 

 

 

 

 

 

(2) Cradle (Charger/Desktop Connector) 

Connects your PC-EPhone and desktop 

PC to copy and synchronize various data 

and also charges the battery.  

 

 

 

 

(3) AC Adapter 

Used to connect the cradle to an external 

power source. 

(110V, 220V compatible / 50~60KHz) 
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II. CF (CompactFlash) Memory Card 

Your PC-EPhone automatically recognizes and enables the use of various types of 

CompactFlash Type II cards approved for Window CE use. 

As PC-EPhone supports CF card Hot Swaps, you can insert or remove cards when your PC-

EPhone is operating. Types of CF cards include Memory cards, LAN cards, and I/O cards. 

 

For information on PC-EPhone compatible CF cards, see PC-EPhone’s 

online customer support site. 

 

 

(1) How to install a CF card 

To insert a CF card:  

 

1. Remove the CF card slot cover. 

2. Place the CF card top facing upward and insert the card’s Pinhole edge into the slot. 

Carefully press the card into the slot until you feel it has clicked into the connector 

inside the slot.  

3. You can now use the card. To check if it was properly installed, tap My Computer 

on the Windows CE screen, the on the My Computer screen. You will find Storage 

Card. 
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If the CF card does not go in smoothly when inserting it, check 

if the correct side is facing up and attempt to insert again. Do 

not use excessive force.  

 

 

 

(2) Storing the CF Card after removal  

To store the CF Card after removal you should:  

 

1. Slowly remove the CF card from the card slot.  

2. Close the cover.  

3. Keep the card in a closed case to protect it from dust and moisture.  

 

The data stored in the memory card remains as it is even if the 

card is removed.  

 

 

 

(3) Tips for use  

��Some CF cards including the Modem Card and GPS Reception Card consume large 

amounts of power. To prevent battery drainage, use your PC-EPhone placed in the 

cradle when using a CF card. 

��When remaining battery power is low, do not attempt to store data in a CF card. 

Data loss may occur. Either use your PC-EPhone placed in the cradle, or continue 

working after changing the battery to a fully charged one.  

��Keep CF card that is not in use in a closed case to protect it from dust and moisture. 

��Do not power off your PC-EPhone or remove the CF card while storing data onto a 

CF card.  
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Chapter 9  

Tips & Troubleshooting 
 

 

This chapter contains troubleshooting information that will help you solve problems and difficulties you 

may encounter while using your PC-EPhone. For answers to ActiveSync and communication related 

problems, refer to ActiveSync Help or Help provided by your Internet Service Provider (ISP). 

 

The information in this chapter will help you: 

 

Maintaining your PC-EPhone in its Best Condition 

Reset your PC-EPhone  

Backup/Restore Data 

Troubleshoot basic problems with PC-EPhone 

Tips for better using PC-EPhone  

Travel safety of PC-EPhone 
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I. Maintaining your PC-EPhone in its Best Condition 
 

Touching the PC-EPhone screen with your hand will leave a trace of natural oil that will 

make the screen difficult to read. To clean the screen, instead of directly spraying glass 

cleaner on the screen, use a soft cloth sprayed on it. 

 

Be sure to turn off your PC-EPhone before cleaning it. 
If dirt or water has gotten into your PC-EPhone unit, take it to the 
nearest dealer to have it repaired. Dirt or water may cause 
malfunctions. 

 

Do not use excessive force when inserting CF Cards. 

Do not meddle with the cable while synchronizing with your partner PC until 

synchronization is complete. 

Be careful not to drop your PC-EPhone and to avoid severe impact. Do not place heavy 

materials on the LCD screen. Delicate internal components may be damaged. 

Damage caused by user negligence does not qualify for free services even during the 

warranty.  

Radiated interference from other electronic equipment may affect screen and the modem 

functions. However, removing the source of interference from the PC-EPhone will return 

the display and modem functions to normal. 

Your PC-EPhone was designed to operate at temperatures between 0°C to 40°C (32 ~ 

104°F). Exposing the device to temperatures outside this range may result in a loss of 

data. Be especially careful not to leave your PC-EPhone in the extreme temperatures in 

a car during summer and winter. 
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II. Reset your PC-EPhone  
Your PC-EPhone provides you with the following three ways of restoring. For more detailed 

information on resetting, refer to the “Resetting Systems” section in chapter 3. 

 

 

When the system does not operate properly, conduct reset in the order of 
Soft Reset, CDMA Reset, and Hard Reset, if possible. 

 

 

(1) Soft Reset 

A soft reset restarts your PC-EPhone’s operating system and reallocates its RAM.  

 

When you perform a Soft Reset, you will lose unsaved data in all 
open documents or programs. Be sure to save all data beforehand. 

 

A Soft Reset may be performed in the following instances.  

When your PC-EPhone’s response slows down suddenly. 

When your PC-EPhone appears to be frozen or locked up. 

After restoring data from a backup file. 

 

A Soft Reset is performed in the following method. 

Press the “Reset” button on the backside of your PC-EPhone using the stylus. 

 

 

(2) CDMA Reset 

A CDMA reset will have the same affects on the system as a Soft Reset, and will reset 

the CDMA module. 

 

A CDMA Reset may be performed in the following instances. 

When the system does not operate properly even after a Soft Reset. 

When the CDMA module is not activated, that is, when nothing appears on the 

CDMA Status Display. 

 

A CDMA Reset is performed in the following method. 

After detaching battery from PC-EPhone battery slot, reattach it. 
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(3) Hard Reset 

A Hard Reset restores your PC-EPhone to its original factory settings, erasing all 

information that is not stored in the Intel Persistant Storage Management (IPSM).  

 

When you perform a hard reset, you will lose all information that is 
not stored in the Intel Persistant Storage Management (IPSM), 
including data files, system settings, and programs you have 
installed. Be sure to save all data in a secure place using system 
backup methods (ActiveSync or Backup Utility) before you perform 
a Hard Reset.  

 

 

You can restore data after a Hard Reset by using backup data. For 
detailed information on how to restore, refer to “Chapter 5 Backing 
up and Restoring Data” 

 

 

A Hard Reset may be performed or may occur in the following instances.  

When the user has forgotten the password. 

When your PC-EPhone does not operate even after performing a Soft Reset and 

a CDMA Reset. 

When the backup battery is fully drained (In this case, the system automatically 

performs a Hard Reset). 

 

A Hard Reset is performed in the following method. 

Simultaneously press the “Reset” button on the backside of your PC-EPhone 

with your finger and the “Power” button on the right side, using the stylus. 

First lift the stylus from the “Reset” button on the backside of your PC-EPhone 

and lift your finger from the “Power” button on the right side about 0.5 second 

later. 
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III. Backup and Restore Data 
Your PC-EPhone provides you with various methods of backing up and restoring data according 

to your needs.  

 

Full Backup/Restore 

Using ActiveSync or the Backup Utility, you can safely store all of the system’s data 

(excluding ROM).  

 

Backup/Restore using Backup Utility 

On the Start menu, point to Programs, Accessories, then tap Backup/Restore, and you 

can Backup/Restore data to/from the IPSM or a CF Memory Card by using the bUSEFUL 

Backup Wizard. For more information, see online help on Backing up and Restoring 

data. 

 

Backup/Restore by file 

You can back up needed files to your desktop PC or an external device (CF Memory 

Card) using ActiveSync and Windows CE Explorer.  

 

For more information on backing up and restoring refer to “Chapter 
5 Backing up and Restoring Data” 
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IV. Troubleshoot basic problems with PC-EPhone 
The information below describes common problems that arise while using the PC-EPhone and 

how to solve them. 

 

PC-EPhone runs very slowly or the system does not operate properly. 

As your PC-EPhone’s capacity falls short, compared with that of your desktop PC 

resources, the memory of PC-EPhone may be drained when many applications are run 

simultaneously, therefore causing a slowdown or a temporary suspension. Run only the 

least number of necessary applications as possible. When this problem occurs, close 

unnecessary applications. If the problem persists, Reset your PC-EPhone and proceed 

after the system’s memory has been re-adjusted. 

 

For information on how to reset, see the “Reset your PC-EPhone” 
section in this chapter. 

 

Reset in the order of Soft Reset, CDMA Reset, then Hard Reset. 
 

 

“Backup Battery Very Low” Warning message keeps appearing. 

The Backup Battery of your PC-EPhone acts as a supplementary power source in order to 

prevent losing data in case the main battery is drained. When such a message appears, 

quickly replace the Main Battery or supply power to your PC-EPhone using the charger so 

as not to lose data, and also charge the Backup Battery.  

 

This message may continue to appear until the Backup Battery is 
fully charged, even if the Main Battery is sufficient. In this case, use 
your PC-EPhone while placing it in the charger.  
 

 

Display screen automatically turns off when PC-EPhone is not used for a certain 

period of time. 

In order to maximize power usage, your PC-EPhone automatically converts into a Sleep 

mode when there is no user input for a certain period of time. At this time, all data is 

properly preserved and when you press the Power button, your PC-EPhone is restored to 

the state it was in before converting into the Sleep Mode. To set the auto-suspend time, 

alter the following settings. 
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On the Start menu, point to Setting, Control Panel, then tap the Power icon, and then 

the Power Off tab. On Sleep mode setting, adjust the number of minutes before auto-

suspend occurs. After the set period of continuous idle time, your PC-EPhone will 

automatically convert to the Sleep mode. 

 

PC-EPhone does not automatically convert to Sleep mode during data 

communications (Internet Access) or when connected to a desktop PC. 

This is not a error. If the PC-EPhone converts to the Sleep mode during data 

communications or when connected to a desktop PC, the connection is broken, in turn 

disabling further communications. Therefore, the PC-EPhone is designed not to convert to 

the Sleep mode in these cases. You may of course manually (press the Power button on 

the right side) convert your PC-EPhone into the Sleep mode. Be careful not to disconnect 

communications. 

 

Response to stylus input is inaccurate.  

There is something wrong with the touch screen setting. On the Start menu of your PC-

EPhone, point to setting and tap Control Panel and the control panel screen appears. 

Select the Stylus icon and re-adjust the recalibration screen in the Calibration tab. 

 

Stylus double-tap does not work properly. 

Re-adjust double-tapping in the following method.  

On the Start menu of your PC-EPhone, point to setting and tap Control Panel and the 

control panel screen appears. Tap the Stylus icon and re-adjust the tap intervals 

according to the directions given on the Double-Tap tab. 

 

It takes too long time in charging the battery of PC-EPhone. 

Actually, it takes too long time in charging the battery of PC-EPhone. In order to charge it 

quickly, press the Power button on the right side of PC-EPhone to convert into the Sleep 

mode. 

 

PC-EPhone does not operate even when the Power button is pressed. 

It may not operate mainly in the following cases. 

 

Check to see if the Battery Lock of the Main Battery in the back is switched upward. 

PC-EPhone does not operate if the Battery Lock is switched downward. 
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Battery power is low : When battery power is low, PC-EPhone suspends operation in 

order to preserve data. In this event, you must replace the battery or use the PC-

EPhone placed in its cradle. 

In all other cases, restart your PC-EPhone by pressing the Reset button on the 

backside.  

 

All unsaved data in open documents and programs will be 
erased as a result of reset. 

 

If the methods given above do not work, try a CDMA Reset and/or Hard Reset on 

the system. You can perform a CDMA Reset by detaching the battery and then 

reattaching it, and a Hard Reset by simultaneously pressing the Power button with 

your finger and the Reset button in the back with the stylus, and then lifting the 

stylus from the Reset button and your finger from the Power button about 0.5 

second later. In this event, all data stored in the RAM is erased, so be sure to 

regularly back up your data in advance (see “Chapter5 Backing up and Restoring 

Data”). 

 

PC-EPhone’s display turns dim or seems to disappear in bright surroundings. 

As PC-EPhone uses a TFT LCD display screen and a backlight, it is hard to read the 

screen in places with direct sunlight. Use your PC-EPhone in shaded areas or indoors 

whenever possible. 

 

The font size is either too small or too large.  

Your PC-EPhone’s standard font size is preset to fit the size of the screen. In cases where 

you need to change the standard font size, tap Control Panel on the Start menu so that 

the Control Panel display appears. Select System Font and adjust the font size to the 

size you desire. 

 

After the font is altered, the system performs a Soft Reset. Close all 
programs before performing this task. 

 

“Program memory shortage” or “Storage memory shortage” error occurs while 

using the PC-EPhone. 

This problem occurs when your PC-EPhone’s RAM space is insufficient as you are 

running too many applications or using too many data files. In this event, close as many 

unnecessary applications as possible to expand “program memory” or erase 

unnecessary data files. If the problem persists, perform a Soft Reset on your PC-EPhone. 
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V. Tips for better using PC-EPhone 
Battery 

Change batteries quickly and do not switch the Battery Lock upward when the battery 

is detached. If there is no power supplied to the cradle, it is unable to connect to a 

desktop PC.  

As charging the Backup Battery takes a substantial amount of time(about 24 hours), 

you should use your PC-EPhone placed in the cradle when possible so as not to fully 

drain the battery. 

Be careful that PC-EPhone’s terminal does not get caught when installing the Main 

Battery. 

The battery terminals can be damaged if excessive force is used.  

The battery’s charging status may be temporarily displayed differently according to the 

conditions in which it is used. In other words, a amount of electric power is needed 

when connected to the Internet or during a phone call. In these cases, the battery’s 

charging status may appear to be very insufficient. 

Be especially careful as when the Main Battery and the Backup Battery are fully 

drained, PC-EPhone automatically performs a Hard Reset, resulting in damaging all 

data stored in the RAM and all installed programs. 

 

Reset 

When a reset is needed, try a Soft Reset first. Even after that, if it does not operate 

properly, try a CDMA Reset then a Hard Reset. However, when you perform a Hard 

Reset, you will lose all information that is not stored in the Intel Persistant Storage 

Management (IPSM), including data files, system settings, and programs you have 

installed. Be sure to save all data in a secure place using system backup methods 

(ActiveSync or Backup Utility) before you perform a Hard Reset. 

 

ActiveSync 

You may not use a LAN Card with PC-EPhone placed in the cradle and running 

ActiveSync. However, you may use a LAN card when ActiveSync is not in operation. 

For infrared communication, there must not be any obstruction between the notebook 

and the PC-EPhone, and the distance between the two IR ports must be under 1m. 

Also, you must align the IR ports of the two devices so that they are aimed directly at 

one another. 

As for synchronization items, when establishing Partnership or on the ActiveSync 

screen, tap Options on the Tools menu and you may set an additional 
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synchronization items. 

A desktop PC can establish partnerships with several Windows CE based Palm-size 

PCs, whereas a single Windows CE based Palm-size PC can establish partnerships 

with two desktop PCs. 

 

Backup/Restore 

IPSM’s data Backup/Restore speed is slower than that of RAM. Copy frequently used 

data or data requiring quick speeds onto the RAM. 

Automatic backup is only possible when a partnership is established with a desktop 

PC.  

Only a manual backup is possible if the setting is at Guest. 

 

Phone program 

For efficient battery use, if you are on the phone for an extended period of time, it is 

recommended to press the power button on the right side and turn off the PC-EPhone 

display screen. 

When the temperature falls below 0°C(32°F) or rises above 40°C(104°F) while the 

Phone program is running, there may be difficulty in transmitting a call due to a LCD- 

characteristic white out occurrence. 

If the phone bell is set at melody, be careful, as when the melody WAV file is deleted, 

so is the phone reception bell. 

You may not transmit SMS during data communications (Internet access). 

 

PC-EPhone Web browser 

While connected to the Internet, that is, during data communications, you may not use 

both the Phone program and SMS. If a short message is received during data 

communications (Internet access), the Internet access may be broken according to 

the preference for ISP. 

PC-EPhone does not automatically enter the Sleep mode while Internet access (PC-

EPhone Web browser, E-mail) programs are in use. 

 

PC-EPhone and others 

To turn off your PC-EPhone, do not switch the Battery Lock downward and use the 

Power button on the right side of your PC-EPhone. 
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VI. Travel Safety of PC-EPhone 
For safety and convenience when traveling with your PC-EPhone, follow the guidelines given 

below. 

 

General  

Back up your PC-EPhone data to a CF Memory Card before you leave. 

Keep the backup CF Memory Card in a safe place and keep it under care together 

with your PC-EPhone. 

Disconnect all external devices from PC-EPhone. 

Take a power supply and a sufficiently charged battery with you. 

Carry your PC-EPhone in a protective case. Do not pack it with your other luggage. 

Check airline regulations before using your PC-EPhone aboard an airplane. 

Regulations on on-flight usage of electronic devices differ by airline.  

 
International Travel 

Before traveling internationally with your PC-EPhone, check the following : 

Check local customs regulations. 

If using an external CF Card modem, be sure to have the correct modem and cable 

for the country you are visiting. The Phone connection number may differ from country 

to country. 

 
Transporting Guidelines 

When transporting your PC-EPhone, follow the guidelines listed below: 

Store a backup copy in a safe place. 

Be sure that the materials for backup (CF Card, diskette, or tape) is not exposed to 

electrical or magnetic impulses while in transit. 

Turn off your PC-EPhone and disconnect all external devices. 

Pack your PC-EPhone and all external devices (cradle, cables, etc.) in their original 

packing boxes or in protective cases. 

Airport security inspecting devices include the X-ray Machine, Magnetic Detector (a 

walk through inspector), and the Security Magnetic Wand. Though the X-ray 

Machine does not affect the PC-EPhone, defects may occur when PC-EPhone pass 

through the Magnetic Detector or the Security Magnetic Wand. 
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Chapter 10 

Support and Service 
 

 

This chapter will give you information on PC-EPhone related Web sites, where you can obtain more 

product information, and on customer support. 

 

I. Web Sites 

http://www.cb.co.kr 

You can access information related to Cyberbank Corp. as well as the current 

conditions of the company. 

http://www.pc-ephone.co.kr  

This is a customer support web site for the PC-EPhone. Here, you can see the most up-

to-date information on the PC-EPhone (User’s Manual and various information), customer 

questions, and detailed information and reports on the product. You may also download 

S/W that will help you keep your PC-EPhone in its best condition and install it in your PC-

EPhone.  

II. Service Center 
Your PC-EPhone is warranted against malfunctions caused by manufacturing defects and is 

entitled to free repair during the warranty period, and after the warranty has ended, you may 

receive repairs for defects with a service charge payment.  

 

Free repairs do not apply to the following instances even during the 
warranty period: 

Defects resulting from misuse or mishandling 

Unauthorized repairs or modification 

In-transit damage 

Defects resulting from natural disasters including fires and floods 

Defects resulting from power abnormalities 

Abrasion of consumables 

When the warranty is not presented 
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If there is something wrong with your PC-EPhone or if you have questions that the User’s 

Manual does not answer, please contact the nearest service center or the CYBERBANK 

Customer Center. (Tel: 82-2-3483-4545) 

 

III. Purchasing Accessories 
To purchase accessories, contact the dealer from which you purchased your PC-EPhone or the 

CYBERBANK Customer Center (Tel: 82-2-3483-4545) or visit our product support Web Site 

(http://www.pc-ephone.co.kr). 

  

 

 



��������	�
����
�	���	
�����	�� ���	�����

����������� �

	
�����
���
������������������� �

 

 

 

Most people find they can enter text quickly and accurately with only minutes of practice. DioPen 

handwriting recognition includes any character you can type on a standard keyboard. The DioPen 

strokes closely resemble the uppercase letters of the regular alphabet, which makes Diopen 

handwriting recognition easy to learn. 
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�  Lati1 1 Basic Letter - Alphabet  � 

 

 

 

 



��������	�
����
�	���	
�����	�� ���	�����

�  Lati1 1 Basic Letter - Numeric  � 
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�  Lati1 1 Basic Symbol Letter  � 
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�  Lati1 1 Supplement Symbol Letter  � 

Letter Shape Letter Shape Letter Shape Letter Shape 

�  �  ¬  �  

ƒ  ~  �  �  

�  �  ®  �  

�  š  �  Æ  

�  �  �  Ç  

�  œ  �  Ð  

�  �  �  	  


  ¢  �  Ø  

Š  £  �  Þ  

�  �  µ  ß  

Œ  ¥  
  æ  

�  ¦  �  ç  

�  �  �  ð  

�  �  �  �  

�  ©  �  ø  

�  �  »  þ  

�  �  �  
Euro 

Mark 
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�  Accented Letter  � 
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Appendix B  
Hardware Specifications  
 

 

Processor Intel StrongARM SA-1110 32-bit RISC Processor 

Memory 32MB RAM, 32MB Flash ROM 

Display 
4” TFT LCD, 256 colors 

VGA(640x480 resolution, 200dpi) 

Wireless 

Communications 

CDMA : MSM3000, IS-95B 

Voice and data communication 

Interface 

1 Infrared port 

1 CompactFlash Type II Card slot 

1 Serial port 

Buttons 

Phone button, Power button, Record button 

4 way Navigation buttons 

Enter button  

Battery 

Main battery: 1,860 mAh Lithim battery(2,930 mAh, rechargeable) 

Backup battery: Lithium battery(3V, 90mA, rechargeable) 

External input:110 and 220V use 

Output:12V/1.3A  

Charger  

1 Serial cable 

1 A/C adapter 

1 battery slot 

OS Microsoft Windows CE 3.0 

Size 

(widthxdepthxheight) 
127mm x 102mm x 22mm 

Weight 299g(Including battery) 

S/W 

Phone program, SMS, Microsoft Pocket Word, bSquare 
BSpreadSheet, PDF Viewer, PC-EPhone Web Browser (IE4.0 
compatible), E-mail, Contacts, Tasks, Calendar, Calculator, Memo, 
Handwriting Recognizer (DioPen), Backup Utility, Recorder, 
MineSweeper 
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ActiveSync 
A feature of Windows CE Services that manages data synchronization between your PC-

EPhone and desktop PC. You can specify the type of data you want to synchronize. 

 

Backup file 
A duplicate copy of your PC-EPhone files and data that is stored on your desktop PC or on a 

PC Card. This file does not include your PC-EPhone settings and information stored in ROM, 

such as factory-installed software. Use your backup file to restore your PC-EPhone to its 

previous state if your device data is damaged or destroyed or if you have performed a full reset. 

 

Cache 
A special high-speed storage mechanism that saves temporary copies of Web pages and other 

file types as your view them. Your computer can quickly display Web pages you have recently 

visited, because Pocket Internet Explorer can open them from cache instead of having to load 

them again from the Web. Increasing the space designated for your cache folder increases 

how quickly recently visited files are displayed, but decreases the amount of space available 

for other files on your PC-EPhone. You can choose to empty your cache upon exiting Pocket 

Internet Explorer. This saves space your device. 

 

Cookies 
A packet of messages a Web server passes to your Web browser. When you enter a Web site 

that uses cookies, you may be asked to fill out a form with information such as your name and 

interests. This information is passed to your Pocket Internet Explorer browser as a cookie (in 

the form of a text file called cookie.txt). The next time you visit that Web site, your Pocket 

Internet Explorer will pass the cookie back to the Web server, and the server will use this 

information to present you, for instance, with custom Web pages filled with information of 

interest to you. For example, instead of being presented with a generic welcome page, you 

might receive a welcome page with your name on it. 
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Dial-up connection 
A connection between your PC-EPhone and another computer by modem. You can have a 

dial-up connection with an ISP, a network, or with a modem attached to a PC. 

 

Direct connection 
A connection between your PC-EPhone and another computer by means of the sync cable or 

IR port. 

 

DNS 
Domain Name System (DNS) is an Internet service that translates domain names into IP 

addresses. 

 

Full reset 
To return your PC-EPhone to its original state by removing all power, thereby erasing all files 

and data you have saved. 

 

Internet Service Provider (ISP) 
A company that provides access to the Internet. 

 

IP 
Internet Protocol (IP) specifies the format of packets, also called datagrams, and the 

addressing scheme of the Web. Much like a postal system, IP allows you to address a 

package and drop it into the system, but your package is not delivered instantly to your 

recipient. The packets are simply delivered to a server until the recipient downloads them by 

logging onto the ISP server. 

 

LAN 
A local area network (LAN) is a group of computers, usually in close proximity (either in the 

same building or in buildings in close proximity), that are linked together to share files and 

exchange data. 

 

NIC 
A network interface card (NIC) is a card that is installed in a computer so that it can be 

connected to a network. Network interface cards can provide a dedicated, full-time connection 

to a network. 
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ODBC databases 
Open DataBase Connectivity (ODBC), is a standard database access method. The goal of 

ODBC is to make it possible to access any data from any application, regardless of which 

database management system is handling the data. 

 

Partnership 
An established relationship between your PC-EPhone and your PC for the purpose of 

synchronizing and transferring data. Your PC-EPhone can have partnerships with up to two 

desktop computers. 

 

PCT 
Private Communication Technology (PCT) is a protocol that maintains the security and integrity 

of Internet communications by using encryption, authentication, and message-authentication 

codes. The protocol is application independent, and is used by Web browsers and e-mail 

clients to send data via the Internet. PCT is able to negotiate encryption keys as well as 

authenticate a server before data is exchanged by the higher-level application. 

 

POP 
Post Office Protocol (POP) was the first protocol used to retrieve e-mail from a mail server. 

Most e-mail applications (sometimes called e-mail clients) use the POP protocol, although 

some may use the newer IMAP (Internet Message Access Protocol). 

 

PPP 
Point-to-Point Protocol (PPP) is the default method your PC-EPhone uses to communicate 

with the ISP network server. 

 

RAS (Remote Access Service) account 
A network account that enables your PC-EPhone to access your Windows NT network 

remotely. 

 

Remote connection 
A connection between your PC-EPhone and a remote computer or server. 

 

Reset 
A process that either causes your PC-EPhone to restart (soft reset) or causes all data stored in 

RAM to be erased (full reset). 
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Restore 
To return your device to the state it was in when last backed up. This involves copying your 

backup data to your PC-EPhone. 

 

SLIP 
Serial Line Protocol (SLIP) is an older and simpler protocol than PPP. Connecting to the 

Internet via SLIP is very similar to connecting via PPP. 

 

Soft reset 
The process of restarting your PC-EPhone and reinitializing the Windows CE operating system. 

Performing a soft reset will erase any unsaved data in open documents, but will preserve data 

that has been saved. (Also called “warm boot.”) 
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1. Product Warranty 

 

1) Limitation of Warranty 

� This hardware product is warranted against defects in material and workmanship 

and is entitled to free repairs for a period of one year from receipt by the original 

end-user purchaser. If the original date of purchase is obscure, it will be estimated 

by adding 6 months to the product manufacturing date (identified by product serial 

number).  

� The battery is warranted for a period of 6 months from the original purchase. 

However, if the original date of purchase is obscure, it will be estimated by adding 3 

months to the product manufacturing date.  

 

2) Free repairs do not apply to the following instances even during the warranty period.  

� Defects resulting from user carelessness including dropping the product in water, 

bringing close to fire, impressing excessive voltage, and dropping the product 

� Defects resulting from natural disasters including fires, floods, and earthquakes 

� Voluntary repairs or modification performed by the user 

� Defects resulting from repairs or modification performed by a third party other than 

the CYBERBANK appointed service network 

� Defects resulting from reasons other than problems in manufacturing 

 

 

2. CYBERBANK Product License Agreement 

Please read the license agreement carefully before using the product.  

This product includes pre-installed software programs whose rights are not for sale. 

CYBERBANK and the software owners will continue to possess ownership to all 

intellectual property rights of the pertaining software, and by agreeing to this license 

agreement, the user is granted rights to use the software. Using the product implies that 

the user has agreed to the terms of this license agreement. If you do not agree to these 

terms, you must return the product before using it.  
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1) CYBERBANK Product License Agreement 

The CYBERBANK Product License Agreement shall govern the use of all software that 

is provided to you, the user, as part of this product with the exception of Microsoft 

software. Microsoft Products are licensed to you under the Microsoft End User License 

Agreement(EULA). Microsoft software supplier’s warranty may be found on-line, or in 

any documentation or other materials contained in the product packaging, and will 

govern the use of Microsoft software.  

 

2) Use 

You may only use the software on a single computer. You may not reverse or assemble 

the software.  

 

3) Copies and adaptations 

You may make copies or adaptations of the software for archival purposes, or when 

copying or adaptation is an essential step in the use of the software with a computer so 

long as the copies and adaptations are used in no other manner. 

You have no other rights to copy unless you acquire and appropriate license from 

CYBERBANK to reproduce, and CYBERBANK will not be responsible for unauthorized 

copies or adaptations.  

All copies and adaptations of the software must bear the copyright notice(s) contained in 

or on the original.  

 

4) Ownership 

You acknowledge and agree that all software is copyrighted and protected under the 

copyright laws and that the customer does not have any title or ownership of the 

software, except for the Service CD that is included with the product on purchase. You 

acknowledge and agree that a third party software supplier will be authorized to hold 

you responsible for any copyright infringement or violation of this or their own License 

Agreement on their software or part thereof.  

 

5) Transfer of rights in software 

You may transfer rights to the software to a third party only on the following 3 conditions.  

�� You must transfer all your rights to the third party all together.  

�� You must obtain the prior agreement of the third party to be bound by the terms of 

this License Agreement.  

Upon such a transfer, you agree that your rights to the software are terminated and that 

you will either destroy all your copies and adaptations or deliver them to the third party.  
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6) Sublicensing and distribution 

You may not lease, sublicense the software or distribute copies or adaptations of the 

software in the Service CD that is included with your product without the prior  written 

consent of CYBERBANK. 

 

7) Updates and upgrades 

You agree that the software does not include updates and upgrades that may be 

available from CYBERBANK under a separate support agreement.   

 

8) Export clause 

You agree not to export or re-export the software or any copy or adaptation in violation 

of the License Agreement or other applicable regulations.  

 

9) Termination 

CYBERBANK may terminate this software license for failure to comply with any of these 

terms, provided CYBERBANK has requested you to cure the failure and you have failed 

to do so within 30 days of such notice. 

 

 


